
The TAU: A new morphing & resynthesis tool for Kyma
February 2006

Imagine that you could push, pull and reshape the amplitude, frequency, and formant envelopes of your sounds using 
the mouse, Wacom pen, or arrow keys.  The TAU provides a new way to resynthesize, morph, and transmogrify* your 
sounds in Kyma.

The TAU can assist you in aligning the timing, frequency, amplitude and formant envelopes of several files for 
synchronization, morphing or cross-synthesis.  Needless to say, the TAU is also an open invitation to distort and 
deform your sounds in new and entertainingly nonconformist ways!

Introduction
To get a taste for some of the possibilities inherent in this new sound-designing technique, use the Sound Browser to 
listen to the Sound examples in the Kyma Sound Library in a folder called:
 

Kyma Sound Library / Brand new Tau Examples Feb 06

You'll find examples of morphing, time-stretching/frequency/formant-scaling, key-mapped samplers, and purely 
synthetic sounds based on the parameter envelopes extracted from the samples.  Try listening to the Sounds in

Brand new Tau Examples Feb 06 / transmogrification.kym

These examples are based on a new Sound called the TauPlayer.  A TauPlayer reads a tau file which contains one 
or more analyzed samples called psi files.  You can create a tau file using the Time Alignment Utility (TAU) Editor.  
Let's open a TAU editor to get an overview of its parts.

Opening or creating a new Tau editor
To open a Tau editor, open a file of type Any openable file or Tau file (having the extension .tau).  Alternatively, you 
can locate a .tau file in the Sound Browser in the Kyma folder in the Tau files directory and open it by double-clicking 
on the file name. Tau files names are displayed in green in the Sound Browser.

* According to Websters, 'transmogrify' is a humorous coinage meaning to change into a different shape, to transform.



To create a new tau file, use File > New and select Tau file as the file type.

TAU Editor Overview
For example, look in the Tau files folder and open the file called bill calum pete.tau. 

Use the central area to view and warp the selected parameter envelope of the selected file.  To select a file, click its 
tab at the top (in this example, 'count pete' is the selected file).  To select a parameter, click one of the parameter tabs 
along the left side (in this example 'Amp' is the selected parameter).

The strip just above the envelope area contains anchors—points where you can select and drag to warp the timing or 
the value of the selected parameter envelope.  Once you have placed an anchor at a particular time point, the 
envelope value and timing are protected from further modification unless you specifically select and move that point. 

In the strip at the top, the light gray brackets mark unvoiced (transients or noisy) segments in the foreground envelope 
and the gray/pink rectangles mark unvoiced segments in the background envelope(s).

The anchor strip also contains the start loop marker (red triangle pointing right) and the end loop marker (blue triangle 
pointing left).  To change the loop points, drag these markers to new time positions.  For a loop that runs both forward 
and backward, swap the positions of the start and end loop makers so the end loop marker occurs before the start 
loop marker.

At the very top of the editor there are some buttons and menus for editing and playback options (see below for full 
details).

Playing, pausing, scrubbing

Play/Pause: Space bar
Rewind & play: Ctrl+Space
Scrub: Click + drag yellow time cursor 
Jump to a time: 1. Position the cursor to that time

2. Press the equals (=) key or the period (.)

Change playback speed:

Loop, Voiced only, Unvoiced only:



Selecting, warping, grouping, adding, and removing anchors

Select a time segment of the envelope by clicking and dragging in the envelope area.  You can also select existing 
anchors by drawing a boxed selection in the anchor strip.  The background of the selected time segment turns light 
gray.  Anchor points are added at the beginning and the end of a drag (if they were not already present at the start 
point and end point of the drag).  Anchor points within the drag region are selected.

Select a single anchor by clicking on that anchor or by clicking in the envelope-editing area at the time position of 
that anchor or by clicking directly on the anchor itself.

Select a group of contiguous anchors by dragging a boxed selection around the markers.

Select discontiguous groups of anchors using Shift+Click to toggle the selection state of each anchor or boxed 
selection of anchors.

To Warp the timing (horizontal warp) of the selected region(s):
• Click in a selected segment and drag left or right OR
• Click on an anchor and drag left or right OR
• Press the left/right arrow keys or Shift+Arrow keys (for larger changes)

To Warp the value (vertical warp):
• Click directly on the envelope and drag it up or down OR
• Press the up/down arrow keys or the Shift+Arrow keys to nudge the value upward or downward

To Deselect All, click in an empty region of the anchor strip. 

To Group two or more anchors: select them; then click the Grouping button (found at the top of the editor): .  
Any collection of anchors can be grouped (they need not be contiguous).  By default, the start and end anchors of 
unvoiced segments are grouped; however, any combination of anchors can be grouped (they need not have 
anything to do with voiced or unvoiced segments).

When you select an anchor that is a member of a group, all anchors in that group are selected, and the 
Grouping button is depressed: .  Time shifts made to one member of the group are made to all anchors in that 
group.

To ungroup, press the Grouping button, returning it to the Up position: 

To add an anchor, Ctrl+Click in the envelope area or the anchor strip.  Whenever you click on the envelope and drag 
up or down, an anchor is automatically added.  When you do a boxed selection in the envelope-editing area, an 
anchor is added at the beginning and end of the drag.

To delete an anchor, select it, and press Backspace (Windows) or Delete (Macintosh).  Deleting an anchor also 
undoes the warping associated with that anchor.

Loop start and end
To change the loop start and end points, drag the start and end loop markers (red and blue triangles) in the anchor 
strip.  If the end marker occurs before the start marker and you are in Loop mode , the time cursor will sweep back 
and forth between the two markers.

Stereo positioning
Above the anchor strip is a narrow strip containing solid circles.

The bright green circle(s) represent the selected file's position in the stereo field from left to right (the circles of other 
colors show the positions of the files in the background).  To change the position of the selected sound source, drag 
the green circle(s) to the desired position.



If the selected file has multiple channels, you will see a green circle for each channel.  To move them as a group, click 
and drag.  To change the spread (the distance between the circles), hold down the Option (or Ctrl) key while you drag 
one of the circles the left or to the right.

Buttons, controls and menus

Across the top of the editor, there are several buttons and menus related to playback and editing:

 

Record audio output.  NB: Record mode is unaffected by the space bar (this allows you to play or loop the files 
several times during the recording).  The only way to stop the recording is to click on the button a second time to 
toggle it.

Show original envelope in gray (warped envelope in green).  NB: If no changes have been made to the envelope, this 
button has no effect.

The first button cuts playback speed in half each time you click it.  Middle button resets to original speed. Right button 
doubles speed on each click.

Playback mode: Looped, Voiced only, Unvoiced only

Change the loop points by dragging the Red (start loop) and Blue (end loop) triangles  to new positions

Group/ungroup selected anchors (any combination of anchors can be grouped)

This is the minimum frequency, maximum frequency, and unvoiced threshold frequency that were used for analyzing 
the selected file.  To reanalyze using a different set of analysis parameters, click the button.  (See below for more 
details on the analysis process).

  
Use these buttons for live switching between playback modes: Solo, Mix, Morph, Morph2, Cross:

• Solo plays the selected file in isolation
• Mix lets you hear a mix of all the files
• Morph lets you morph from one file to the next (moving from left to right through the file tabs)
• Morph2 is like Morph except that the unvoiced segments are unmodified originals taken from the nearest file.  

For example if you were morphing between two files, when your morph controls are less than 0.5, you will hear the 
unvoiced segments from the first file; when the morph controls are larger than 0.5, the unvoiced segments are those 
of the second file.

• Cross is like Morph except that !AmpMorph morphs between the actual amplitude envelopes of the files (not just 
between the changes you have made in the envelopes).  For example, if you cross a sound with lots of amplitude 
changes (like a drum loop) with a long sustained sound (like someone singing "ah"), you could impose the rhythmic 
amplitude envelope of the drum loop on the sustained timbre of the voice to get a "cross-synthesis" of the two.

The Tau Editor Tools menu includes some commonly used modifications:
• Stretch to maximum duration stretches the voiced segments of the selected envelope such that its total 

duration matches the duration of the longest file in the editor (while leaving the unvoiced segments at their original 
durations).

• Match parameter envelopes aligns the selected parameter envelope of the selected file to the same parameter 



of one of the other files in the background:

º Target envelope is the background envelope whose values you are trying to match
º Voiced only matches the values of the two envelopes during the segments during which both envelopes 

are voiced
º To match the target envelope's values as closely as possible, choose 100%.  For morphing, you might 

want to alter both the selected and the target envelopes to meet halfway.  Do this in two steps: Match the target only 
50% of the way.  Then switch to editing the target envelope, and match at 100%. 

º To match at the selected anchors only, choose 0 as the maximum number of anchors to add between 
selected anchors.  Otherwise, select the maximum number of new anchor points that can be added between selected 
anchors in order to match the two envelopes. 

• Revert to original values restores a value-warped envelope to its original values without undoing any time-
warping.

• Center all pan positions quickly places all files in the center of a stereo field.  This is recommended for 
smoother morphing from one file to another. 

• Distribute all pan positions assigns each file its own area in the stereo field.  This is useful for mixing several 
files while still keeping track of each one separately.

• BPM settings is for showing or hiding grid marks on beats, bars and subdivisions of a specified BPM:

-Toggle the BPM marks on or off
-Enter a tempo in beats per minute
-Specify the number of beats per bar
-Specify the number of divisions per beat that you would like to see
-If the downbeat does not occur at time zero, select the anchor that corresponds to the first downbeat before 

selecting BPM settings from the Tau Editor Tools menu.

Subdivisions of beats are displayed as gray lines, beats are displayed as blue lines, and the first beat of a bar is 
marked with a black line.  For example, this is a drum loop purported to be at BPM = 127.  If you set the grid to 4 
beats per bar with 4 subdivisions per beat, the grid looks like this:



• Move selected file tab right by one positions shifts the currently selected file tab rightward by one position.  This 
can be useful for sorting instrument tones into ascending frequency order in preparation for using the keyboard morph 
in the Galleries.  Since morphing is done from left to right, the editor will have to reload the sound once you have 
changed the ordering of the files.

Click the Galleries button to open a Sound file window with example Sounds based on the files in the Tau Editor.  
(Before you can open the Galleries, you will have to save the tau file to disk so the Sounds can reflect the current 
state of the file.)  Categories include:

Sounds for playing your newly synchronized files
Morphing variations with different parameter controls
Morphing and resynthesis using sum of sines and aggregate synthesis
Crosses and hybrids based on the files
Sounds you can play on your MIDI keyboard, Wacom tablet, Continuum fingerboard, sequencer
Special effects, random loops, etc
Looping Sounds
TauPlayers with randomized parameters
Purely synthetic sounds based on the parameter envelopes extracted from your files

Try clicking the Galleries button.  Kyma creates and opens a new Sound file window containing the example Sounds 
categorized in Sound collections.  For example, open the morphingSounds collection to try out various morphing 
variations, each with different control parameters.  Or select fantasySounds to listen to Sounds based on frequency 
modulation, FOF, filtering, and other synthesis techniques.

Selecting files
In the Tau editor, you can view and edit the parameter envelopes of one, two, or several files.  The filenames are 
displayed across the top of the editor on tabs.  To edit one of the files, click on its tab to bring it to the front.  The 
parameter envelope of the edited file is displayed in the foreground (in bright green).  To step through the tabs in order 
from left to right, use the Tab key.  Shift+Tab steps through the tabs in reverse order (right to left).

If the file is stereo or multichannel, the time edits made to one channel are made to all the channels so that linked files 
stay synchronized.  However, you can edit the frequency and formant envelopes of each channel independently.   
Multichannel files are represented by "stacked" tabs:



You can select and edit one parameter envelope of one channel at a time.  To switch to another channel, double click 
the tab.

Adding, and removing files
To add a new file to the editor, drag it from the Sound Browser and drop it into the envelope-editing area of the Tau.  

Or you can click the Plus sign and use the file browser to select the file from the disk.

You can drag a .psi file, a Samples file (.aif, .wav, .sdii) , another .tau file, or an arbitrary Kyma Sound into the central 
area of the Tau editor.  If you drag in a .psi file into the editor you can begin editing it immediately.  Similarly, if you 
drag a .tau file into the editor, it will add all of its .psi files to the open editor.

If you add a Samples file to the editor, it will first analyze the sample to produce a .psi file and then add the .psi file to 
the editor.  If you drag an arbitrary Kyma Sound into the editor, it will first record that Sound, then analyze it to produce 
a .psi file, and then add it to the editor.  (More details on the Analysis process are provided below).

If you add one channel of a multi-channel psi file, a dialog box will give you the option of linking the remaining 
channels to the first file.  Multichannel psi files are identified by one of the extensions:  .L, .R, .C, .LS, .RS, or .LFE.  
For example, you might see a file named 'click.L.psi'.  (In the current version, only stereo playback is supported but 
you can have multiple files spread across the stereo field and linked together as a single multichannel file).

NB: You cannot combine .psi files whose original recordings were made at different sample rates.  If you run into this 
problem, decide on a common sample rate and re-record one of the files at that sample rate before reanalyzing it to 
create a Psi file.

 To remove the currently selected file from the editor, click the minus button.

NB: Each time you add or remove a file you are changing the architecture of the underlying editor Sound.  The next 
time you press the space bar to play or scrub, the editor will reload the Sound first.

Parameter envelope tabs along the left edge
For each file, you can view and edit three parameter envelopes: amplitude, frequency, and formant.  You can also 
view (but not edit) the bandwidth envelope (which is used for setting the voiced/unvoiced threshold in the analysis 
step described below).

To edit a different parameter envelope, click the appropriate tab.

Undo and redo
To undo an action, select Undo from the File menu (or use Ctrl+Z).   To redo the last undone action, select Redo 
from the File menu.

There are unlimited levels of undo.  The undo stack is cleared whenever you save the file to disk.

Time and value information
As you move the cursor, the time and the parameter value at the center of the cross hairs are displayed just to the 
right of the cursor point.  When the cursor is directly over the selected envelope, the cursor changes to a bulls eye 
and the value displayed is the exact value of the envelope at that time.

Creating a new tau file

Create a new, empty tau file using File>New and select file type Tau file. Next, add some psi files to the editor by 



dragging them from the Sound Browser or by clicking the Plus (+) button.

Dragging psi files from the Sound Browser
For this example, find Tau Files/psi/count calum.psi in the Sound Browser.  Drag it from the Sound Browser and 
drop it into the parameter envelope area of the Tau editor.

Next, add count pete.psi to the editor using the same procedure.

Zoom to fit
To fit the entire file in the editing window, click the zoom-to-fit button at the lower right corner  of the editor.

Selecting psi files from the File Dialog
To select the psi files using the standard file dialog click the Plus (+) button on the right edge of the editor.

Adding Multichannel files to the editor
The 'calum' and 'pete' examples are mono, but you can also edit stereo or multichannel files.  Multichannel files are 
saved as individual mono files sharing the same name followed by '.L' '.R' '.C' '.LS' '.RS'  or '.LFE'.  (For the time 
being,  playback is limited to stereo files (.L and .R), but the editor is ready for multichannel formats).

When you drag a psi file with one of the multichannel extensions into the editor, you have the option of also selecting 
any file from that folder having the same name but a different extension.  For example, if you were to drag in a file 
named 'CF Snap01.L.psi, the following dialog box would open:

Unvoiced segments

An unvoiced segment is a time interval during which the brightness or "bandwidth" of the signal exceeds a threshold 
(more on this later, in the section on Analysis).  In the foreground file, unvoiced intervals are indicated by light gray 
"bridges" over the time interval.  The unvoiced intervals of the background file are shown as solid dark pink 
rectangles. 

Initially, there is also an anchor marking the beginning and end of each unvoiced interval and these anchors are 
grouped to protect you from accidentally time-stretching or value changing an envelope during unvoiced material.  
However, you can ungroup these anchors or even delete them if you like; the light gray bracket will remain, marking 
the unvoiced segment.  The unvoiced segments of the background envelope(s) are marked by the grayish pink 
rectangles.



Time alignment
To align the two files in time, start by stretching the total duration of the shorter file to match that of the longer file.  
Bring the shorter of the two files to the front (by selecting the 'count pete' tab).  From the Tools menu at the top of the 
Tau editor, select the first option: Match maximum duration.

Listen to the results, by tapping the space bar.  The 'count pete' file is softer but you can adjust the !Gain parameter 
using the VCS or MotorMix. 

To listen at half speed, click the "1/2" button at the top of the editor; restore normal speed by clicking the middle 
button. 

To scrub, grab the yellow cursor and drag it across the time of interest.  If you want the cursor to jump to a specific 
time, position the cursor at that time point and press the equals (=) key or a period (.).

To add a new anchor, Ctrl+Click at any time point.  Alternatively, you can click directly on the envelope outline and 
drag up or down to automatically add a new anchor, select it, and begin warping all at once.

 If it is impossible to line up the envelopes without ungrouping the unvoiced pairs, select one anchor in the pair, and 
press the grouping button at the top of the window to ungroup  

Envelope value alignment
Once you are satisfied with the time alignment, adjust Pete's amplitude envelope to more closely match Calum's.  
First, select all (Ctrl+A).  Then use Shift+UpArrow to adjust Pete's amplitude envelope upwards.

To warp one point of the envelope up or down, click and drag on the envelope outline itself.  Movement is restricted to 
the vertical direction so you don't have to worry about accidentally warping the time when you are working on the 
amplitude.

To warp one point of the envelope left or right in time, select the anchor point itself; movement is restricted to the 
horizontal direction so you won't accidentally change the parameter value at that point.

Now that the amplitudes are more closely matched, you can make additional small adjustments to time or amplitude 
until you are satisfied with the synchrony.

Panning
Notice that the two files are panned to different channels so you can more easily hear differences in onset times while 
scrubbing.  To change the pan position of the foreground file, drag the green circle left or right.  For morphing, it's best 
to align the files in the same stereo position using the Center all pan positions option from the Tools menu at the top 
of the Tau editor.



Testing the alignment for morphing
So far, we have been listening to a Mix of the two files.  To test how well the files are lined up for morphing, click the 
Morph button at the top of the editor.

  

In the VCS, each Morph fader controls the morphing of a separate parameter envelope:

!MorphA: Amplitude
!MorphF: Formant
!MorphP: Pitch
!MorphS: Source
!MorphT: Timing

At the midpoint of the morph faders, you will hear exactly what you have specified in the editor.  When you align 
parameter envelopes in the Tau editor, you are specifying the halfway point of a morph between the timing, 
frequency, formant, and amplitude envelopes of the two files.

For example, when !MorphA is at 0, you hear Calum's amplitude envelope.  When it is at 1, you hear Pete's amplitude 
envelope.  Halfway in between, you hear the envelopes as you have them matched in the editor. On the other hand, 
the Formant morph won't have any effect in this example because we haven't made any adjustments to the formant 
envelopes.

Pitch and Source are special cases.  Even if you haven't edited the frequency envelopes, the Pitch morph gives you a 
smooth transition from Calum's pitch envelope to Pete's envelope.  The Source morph gives you a transition from 
Calum as the sound source to Pete as the sound source.  However, if you do match the pitch envelopes in the editor, 
the matched envelope will be used as the halfway point of the morph.

Editing a different parameter envelope
To edit the frequency or formant envelope, click the corresponding tab on the left side of the editor.  Often, the formant 
and frequency envelopes can give you time alignment clues that are not visible in the amplitude envelope alone.

Recording the audio output of the Tau Editor
You can record the audio output of the Tau Editor while you are playing, pausing, scrubbing and otherwise tweaking 
the parameters.  The Record button is at the top of the editor on the left: a toggle button containing a solid gray circle.  
When you are recording, the circle turns red; otherwise it is gray.
 

To record:
1. Click the record button: 
2. Specify the number of channels and the file formant.
3. Give the file a name and specify where to save it on the disk.
4. Press the space bar toggle between play and stop (this won't stop the recording).

You can tell when you are recording because the Record button will be red:

While recording, you can Loop, change modes, adjust the Gain and Morphing faders of the VCS, etc.
The audio output of the Tau editor will be recorded into the samples file you created.

5. To stop recording you must click the Record button a second time (it will change from red to gray to indicate 
that you have stopped recording)

6. Now you can open the recorded file in Kyma or another editor to trim it and save the best parts.

Galleries



Save the file on disk using File>Save (or Ctrl+S).  Click the Galleries button so you can listen to some Sounds based 
on one or both of the edited files.

Analyzing
If you drag a sample into the Tau editor, the editor performs a Period Spectrum Identification (PSI) analysis on it and 
saves the result as a psi file first before displaying it in the editor.   You can drag an arbitrary Sound into the Tau editor: 
the editor will first record the Sound to disk as an .aif file; then it will perform the PSI analysis to create a .psi file.

PSI analysis works best on monophonic samples with little or no reverb.  It is primarily intended for harmonic or mostly 
harmonic signals of a few seconds in length (such as a speech phrase, a single tone from a musical instrument, or a 
short melodic loop from a monophonic instrument) but interesting results can also be obtained with percussive 
samples (such as drum loops) or sound effects (such as engines or wood creaking).

Note, the Tau editor is not intended for analyzing or editing single cycle waveforms or control functions; the Samples 
File Editor is still the best editor to use for creating single cycles, control functions, and for sample-accurate cutting 
and pasting.  If the file you are analyzing is too short you will see a warning message.

Analyzing a sample to produce a psi file
For example, create a new Tau file.  From the Sound Browser, drag count bill.psi from the folder of Kyma/Tau files/psi 
and drop it into the editor.  Next, drag the sample called count.aif from Kyma/Samples/Speech and drop it into the 
editor (or click the Plus button and locate count.aif using the File Dialog).

Count.aif is a samples file, so the Tau editor will analyze it and save it before displaying it.  When the editor asks 
where you would like to save the psi file, save it as count jeff.psi in the psi folder.  The editor will then prompt you for 
the following analysis parameters with the default values:

Click OK to use these default values for the analysis; then sit back and watch the progress thermometer as Kyma 
performs the Period Spectrum Identification (PSI) analysis.

Checking the analysis
Once the analysis is complete, you can check the results and, if necessary, make refinements to the analysis 
parameters; you can then reanalyze with the new parameters by clicking on the analysis parameter range button at 
the top of the editor.  In most cases, though, the default parameters are already accurate enough that a reanalysis will 
not be required.

For example, select the Freq envelope and listen to the resynthesis.  After listening to the entire phrase, try scrubbing 
through the word "one" (press the '=' key to get the yellow cursor to jump to the mouse cursor position; then grab the 



yellow line to scrub).  Notice that, at the end of the word "one", your ear tells you that the pitch is still going up but the 
frequency envelope jumps down and then back up to resume from where it left off (in the screenshot below, this 
occurs right after the vertical gray line).  

This could mean that the upper range on the analysis frequency was not quite high enough to capture the highest 
frequency in the sample.  You could try reanalyzing again with a slightly higher frequency, or you could take a look at 
the original sample in the Samples Editor to see what the frequency is at the end of the word "one".  At the top of the 
Samples Editor you can see an overview of "One, Two, Three" and you can see a gray box around the end of the 
word "One".  In the lower window, we have selected a single cycle of the waveform towards the end of the word.  In 
the upper right corner of the editor, you can read the frequency of that cycle: 120 hz.

When you do the analysis with 120 hz as the upper limit, the frequency envelope no longer has a discontinuity when 
the fundamental frequency goes up to 120 hz:

 

You can also verify the voiced/unvoiced threshold at this point by selecting the Bandwidth parameter and positioning 
your cursor at the threshold value of 2783 (zoom in for more accuracy in the vertical direction).



Typically, the unvoiced (silent or nonharmonic) intervals have a higher bandwidth than the voiced (or pitched) time 
intervals.  By scrubbing through the unvoiced segments or playing through the file at half speed, you can determine 
whether reanalyzing with a higher or lower threshold would more accurately identify the unvoiced segments.  (For 
musical instruments, the word "transient" or noise corresponds with the use of the word "unvoiced" for speech.  In 
both cases, we call a segment unvoiced if it lacks an easily identifiable pitch.)  In this case, the Unvoiced threshold 
appears to be accurate with the possible exception of the unvoiced silence that is missed at the end of the file.

Move your cursor downward until it includes that silence at the end of the file (but not so far down that it includes any 
of the voiced segments).  For example, a value around 1752 would satisfy those requirements:

Once you find a satisfactory value, click the Range and Threshold button at the top of the editor to reanalyze using 
the new frequency and threshold values.  Note that reanalyzing changes the psi file on the disk so the only way to 
undo this operation is to reanalyze again using the original analysis parameters:



Go ahead and click Yes in order to proceed.  Then enter the new high frequency and unvoiced threshold and click OK:

Here's the result with a smooth frequency envelope and an unvoiced segment at the end:

Alignment for morphing
At this point, you might enjoy time-aligning these two example files for practice.  Before you start, take a look at the 
Amp, Freq, and Formant envelopes.  Sometimes it is easier to do the coarse alignment (like the beginnings and ends 
of words) using the amplitude envelope and the fine alignments (like the changes between vowels) using the formant 
envelopes.  Humans also tend to use frequency changes to clarify speech, so you can sometimes see important 
boundaries in the frequency envelopes as well.

NB: If you are preparing the samples for morphing, you may also want to align the pan positions of the two files.  
Otherwise, the morph parameter will also pan across the stereo field.  (This may be a desired result, but usually it's 
best to have as few differences between the two morphing files as possible.)

Reading the analysis parameters of psi Files
The analysis parameters of a psi file are displayed at the top of the editor.  You can also see them in the Sound 
Browser, where the analysis parameters for the selected psi file (low frequency, high frequency, and threshold) appear 
at the bottom of the Sound Browser:



Accessing the information in psi Files
The Fantasy collection in the gallery includes examples of Sounds whose parameters are controlled by information 
extracted from .psi files.  You can access the parameter envelopes by sending messages to a psi file name.  For 
example:

'count jeff.psi' frequencyEnvelopeWithTimeIndex: (1 repeatingFullRamp: 'bill jeff.tau' tauFileDuration s)

The messages you can send to a psi file in order to use one of its parameter envelopes in another Sound's parameter 
field are:

amplitudeEnvelopeWithTimeIndex:
bandwidthEnvelopeWithTimeIndex:
formantEnvelopeWithTimeIndex:
frequencyEnvelopeWithTimeIndex:
unvoicedEnvelopeWithTimeIndex:

To access the duration (in seconds) of a tau file, send the message

tauFileDuration

to the tau file name, for example:

'trombones.tau' tauFileDuration s

You can also access the positions of the start and end loop markers (values in the range from 0 to 1) as follows:



'ah bass.tau' tauFileStartLoop

'ah bass.tau' tauFileEndLoop

The TauPlayer Sound
Using the Tau editor you can combine and modify one or more .psi files and save the combined result as a .tau file.  
The TauPlayer Sound takes a .tau file as one of its arguments and plays back a mix, a morph, or a cross of the 
selected .psi files.  To find examples of TauPlayer in the System Prototypes, type Ctrl+B and search for 'tau'.

TauPlayer might just hold the world's record for the number of Sound parameters, so without further ado, here is a list 
(This same info is obtainable in Kyma by hovering the cursor over the name of each parameter, clicking on the name 
TauPlayer in the lower right corner of the parameter fields, or by selecting Describe Sound from the Info menu):

TauPlayer

A TauPlayer plays back a tau file (previously created using the Tau editor) as a mix, a morph, or a cross of the 
constituent Psi files. Once you have selected a Tau file, use the pull down menu (located to the right of the disk 
icon) to select/deselect the Psi files that should be combined.
In Mix mode, you can scale the frequency, formant, amplitude, and rate of the files.  If only one Psi file is selected 
(or if you specify the name of a Psi file rather than a Tau file in the TauFile field), you can use this Sound to scale 
the frequency, formant, amplitude and rate of that Psi file.
In Morph mode you can, additionally, control the interpolation from one file's parameter envelopes to those of 
another file (in addition to scaling the frequency, formant, amplitude and rate parameters).
You can trigger the playback, set the playback to loop, or control the TimeIndex using a hot value or expression.

To create a Tau file, use File New and select TauFile as the file type.  Then select two or more Psi files for 
alignment or warping.  (To create a Psi file, drag any Sound into the Tau editor, save it as a samples file, and then 
follow the analysis steps to create and save a Psi file).  When you save in the Tau editor, you create a Tau file that 
can be played by the TauPlayer.

TauFile
Select a Tau file; then use the drop down menu just to the right of this field to select which of its Psi files should be 
heard in combination. The selected Psi file names are displayed in green.  To toggle the selection state of a Psi 
file, select it from the drop down list.



To create a Tau file, use the Time Alignment Utility (Tau) editor.  The Tau editor takes several Psi files and 
presents you with envelopes for each of the analyzed parameters: frequency, amplitude, and formant.  You can 
use the Tau editor to modify the timing and the values of these parameters (for example, by bringing the 
envelopes of two or more Psi files into alignment with each other).  Once you have saved a Tau file you can play it 
in the TauPlayer.

To play back a single, unedited Psi file (outside the context of any Tau file), enter the name of the .psi file here (or 
select it by clicking the disk icon and using the File browser).  A single Psi file can be referenced by several 
different Tau files (and might sound very different in the context of each Tau file depending on what kinds of 
modifications were made to it in the Tau editor).

Frequency
Range: (0, (SignalProcessor halfSampleRate))
This is the original frequency envelope (FreqScale is a modification to this envelope).  To use the original 
frequency envelope of the Psi file(s), type the word 'default' in this field.  You can also do arithmetic on the default 
envelope, for example:
default + !FreqOffset hz

To override the default envelope, specify a frequency in units of pitch or frequency. The following are all ways to 
specify the A above middle C:
440 hz                     (in hertz or cycles per second)
4 a                           (as the 4th octave A)
69 nn                       (as a MIDI notenumber)
4 c + 9 nn                (as 9 half steps above middle C)
0.00227273 s          (inverse of a period at 44.1 kHz sample rate)

The following are examples of how to control the frequency using MIDI, the virtual control surface, or a third-party 
program:
!KeyPitch                             (key number in units of nn plus pitch bend)
!KeyNumber nn                   (MIDI notenumber)
4 c + (!Range * 12 nn)   (continuous controller from 4 c to 4 a)

An example random pitch expression:

0.2 s randExp s random * !Interval + !LogFreq nn

FreqScale
Range: (0, ~(2.0**Cost))
FreqScale is multiplier on the value in the Frequency field.  To use the time-varying frequency warping defined in 
the Tau file, type 'default' in this field.  To override the default frequency scaling enter a fixed or hot value for 
scaling the frequency envelope.  Some examples:

!ScaleFreq

0.2 s random abs smooth: 0.2 s + 0.5

FormantScale
Range: (epsilon, ~(2.0**Cost)), where epsilon is a small number > 0
To use the formant warping defined in the Tau file, use 'default'.  Otherwise, you can override the default formant 
scaling by entering a fixed or hot value for scaling the formant envelope, for example:
!ScaleFormant * 1.5 + 0.5.
NB: Protect the value of FormantScale so that it is always larger than 0!  A FormantScale of 0 results in a silent 
output and cannot be restarted.

AmpScale
Range: (0, 1)
To use the amplitude warping defined in the Tau file, use 'default'.  Otherwise, you can override the default 
amplitude scaling by entering a fixed or hot value for scaling the amplitude envelope, for example: !Amp

WarpVoicedOnly



When this box is checked, the file playback will be warped during voiced segments ONLY.  Unvoiced segments 
will play back unmodified.  In other words, if you scale the frequency, formant, amplitude, or rate, you will affect 
the voiced segments of the file ONLY.  If you morph from one Psi file to the next, no morphing will occur during the 
unvoiced segments (if this box is checked); the unvoiced segments will come directly from one of the original files, 
whichever one is closest to the morph values (morphing proceeds from left to right through the files according to 
the order they appear at the top of the Tau editor).

Trigger
Trigger or retrigger the file to start at the beginning.  The trigger occurs on the transition from 0 to a non-zero 
value.  To avoid looping, set LoopMode to None. For example, you could use the following as triggers:
1 for continuous looping (LoopMode should be set to Live)
!KeyDown trigger from MIDI input
(1 bpm: !BPM) repeatedly trigger at the rate of !BPM beats per minute
!sw01 trigger from a MIDI switch or a Virtual Control Surface button
1 s random gt: !p trigger at random

Rate
Range: (-Infinite, +Infinite)
Controls the timing of the playback.  For the original timing, use a Rate of 1.  To play through the files at half 
speed, use a Rate of 0.5.  To play through them twice as fast, use a Rate of 2, etc.  To play through the files 
backwards, use a negative value for Rate.

LoopMode
None: No looping (use the Trigger field to replay from the beginning)
Live: Repeatedly loop through the files under live control of StartLoop and EndLoop
TimeIndex: The expression or Sound in the TimeIndex field controls the play positions in the files

LoopStart
Range: (0,1)
When LoopMode is set to Live, LoopStart controls the relative starting point of the loop within the files.  The range 
of values is (0,1) where 0 corresponds to the beginnings of the files and 1 corresponds with the ends of the files.  
If the value of StartLoop is larger than the value of EndLoop, the files are played backwards.
To control the start time in seconds, use an expression of the form:

!t s / ('default.tau' tauFileDuration)

where !t is the time in seconds and you have substituted the name of your tau file for 'default.tau'. 

LoopEnd
Range: (0,1)
When LoopMode is set to Live, LoopEnd controls the relative end point of the loop within the files.  The range of 
values is (0,1) where 0 corresponds to the beginnings of the files and 1 corresponds with the ends of the files.  If 
the value of StartLoop is larger than the value of EndLoop, the files are played backwards.

To control the duration of the loop in seconds, use an expression of the form:

!t s + !dur s / ('default.tau' tauFileDuration)

where !t is the start time in seconds, !dur is the duration of the loop, and you have substituted the name of your 
tau file for 'default.tau'. 

Start
Range: (0,1)
Start is the point in the file where playback begins on a retrigger.

To control the start time in seconds, use an expression of the form:

!t s / ('default.tau' tauFileDuration)



where !t is the time in seconds and you have substituted the name of your tau file for 'default.tau'. 

End
Range: (0,1)
End is the point in the files where playback stops.

To control the duration in seconds, use an expression of the form:

!t s + !dur s / ('default.tau' tauFileDuration)

where !t is the start time in seconds, !dur is the duration, and you have substituted the name of your tau file for 
'default.tau'. 

TimeIndex
Range: (-1,1)
In the TimeIndex field, -1 corresponds to the beginnings of the files, 0 corresponds to the middles of the files and 
1 corresponds to the ends of the files.  The value in the TimeIndex field corresponds with the playback position in 
the files.  To create a "scrub" control you could use:
!TimeIndex smooth: !Slew s
To create a loop, you could use:
1 repeatingFullRamp: ('nameOfTauFile' tauFileDuration)
To create a random TimeIndex, you could use:
(1 s randExp) s random smooth: 1 s
To control where you are in the file in terms of seconds, use an expression of the form:
(!t s / 'nameOfTauFile' tauFileDuration) * 2 - 1

CombinationMode
The Combination mode specifies whether the Psi files of the Tau file are to be Mixed, Morphed, or Crossed.
Mix: You hear a mix of all selected Psi files as they have been modified in the Tau editor (the Morph parameter 
fields have no effect in this mode)
Morph: The Morph parameter fields select which one of the Psi files you are listening to (with interpolation from 
one to the next, moving from left to right)
Cross: MorphAmp controls which of the Psi file amplitude envelopes is heard.  The other Morph parameters 
behave as in Morph mode

SourceMorph
Range: (0,1)
Source morph controls which of the Psi files you are hearing. When the value is 0, you hear the first selected Psi 
file, when the value is 1 you hear the last selected Psi file and for intermediate values, you hear the selected Psi 
files in between the first and the last.  For example, if you have three selected Psi files and you change this value 
from 0 up to 1, you will hear a smooth change from the first file to the second file to the third file.

When CombinationMode is Mix, the value in this field has no effect.

PitchMorph
Range: (0,1)
PitchMorph controls the transition between frequency envelopes (along with any frequency-scaling you might 
have added in the Tau editor).  For example, if you have three selected Psi files and you change this value from 0 
up to 1, you will hear a smooth change from the frequency envelope of the first file to that of the second file to that 
of the third file.

When CombinationMode is Mix, the value in this field has no effect.

FormantMorph
Range: (0,1)
FormantMorph controls the transition between formant-scaling envelopes (If you have not made any changes to 
the formant envelopes in the Tau editor, this control has no audible effect).  For example, if you have three 
selected Psi files and you change this value from 0 up to 1, you will hear a smooth change from the formant-
scaling envelope of the first file to that of the second file to that of the third file.



When CombinationMode is Mix, the value in this field has no effect.

AmpMorph
Range: (0,1)
When CombinationMode is Morph, the AmpMorph controls the transition between amplitude-scaling envelopes (If 
you have not made any changes to the amplitude envelopes in the Tau editor, this control has no audible effect).  
For example, if you have three selected Psi files and you change this value from 0 up to 1, you will hear a smooth 
change from the amplitude-scaling envelope of the first file to that of the second file to that of the third file.

When CombinationMode is Cross, the AmpMorph controls the transition between the actual amplitude envelopes 
of the Psi files (as distinct from amplitude-SCALING envelopes applied to the Psi files).  This has an effect 
whether or not you have made any alterations to the amplitude envelopes in the Tau editor.

When CombinationMode is Mix, the value of this field has no effect.

TimingMorph
Range: (0,1)
TimingMorph controls the transition between rate-scaling envelopes (If you have not made any changes to the 
timings or durations of the envelopes in the Tau editor, this control has no audible effect).  For example, if you 
have three selected Psi files and you change this value from 0 up to 1, you will hear a smooth change from the 
rate of the first file to that of the second file to that of the third file.

When CombinationMode is Mix, the value in this field has no effect.

Cost
For the maximum range of frequency, formant, and rate scaling, set the Cost value to 3.  For playback with rate 
scaling and small frequency/formant changes, select a Cost of 2.  For playback with time stretching/compression 
only, select a Cost value of 1.  The higher the value of Cost, the more processing power required.


